
Getting Started 
with Transparency
Using Adobe Creative Suite 2 Soft ware

1 Introduction to transparency

3 Creating transparency eff ects

4 Saving, exporting, and printing fi les with transparency

7 Transparency-related resources



Adobe Systems Incorporated • 345 Park Avenue, San Jose, CA 95110-2704 USA • www.adobe.com

Adobe, the Adobe logo, Illustrator, Photoshop, InDesign, Acrobat, Distiller, and PostScript are either registered trademarks or trademarks of Adobe Systems Incorporated 
in the United States and/or other countries. All other trademarks are the property of their respective owners. 

© 2005 Adobe Systems Incorporated. All rights reserved.



I N T R O D U C T I O N  T O  T R A N S P A R E N C Y 1

Introduction to transparency
Th is guide provides basic information for anyone who wants to get started using the transparency fea-
tures in the Adobe® Creative Suite 2 components. If you would like additional information about creat-
ing and printing transparency, you can download the following documents from the Adobe website:

• A Designer’s Guide to Transparency for Print Output Using Adobe Creative Suite 2 Soft ware 
(studio.adobe.com/us/print/main.jsp). Th is document provides detailed information about 
creating transparency eff ects and exporting and printing fi les that contain transparency.

• Transparency in Adobe Applications: A Print Production Guide (studio.adobe.com/us/print/main.
jsp). Th is reference and troubleshooting guide for prepress providers contains detailed information 
about printing fi les with transparency.

 Transparency basics
For graphic artists, the ability to create a variety of eff ects using the transparency features available 
in the Adobe Creative Suite 2 components has both aesthetic and practical benefi ts. You can use 
transparency eff ects like soft  drop shadows, blending modes, and feathered edges to create eye-catch-
ing designs, and the support of transparency across Adobe Creative Suite 2 enables you to use your 
favorite program to create transparent artwork and save the artwork in native format or export it as an 
Adobe Portable Document Format (PDF) fi le for use in other Adobe Creative Suite 2 components.

You can apply transparency eff ects to any object (bitmaps, vector artwork, and type)—including 
native objects created within an Adobe Creative Suite 2 component or placed artwork created with 
other Adobe Creative Suite 2 components. You don’t have to use only Adobe Photoshop® CS2 to create 
transparency eff ects. You can also use Adobe Illustrator® CS2 or Adobe InDesign® CS2.

Illustrator CS2 and InDesign CS2 include four main transparency eff ects: soft  drop shadows, feathered 
edges, blending modes, and opacity. You should also be aware of a process called “fl attening,” which is 
explained on the next page. Here are brief descriptions of the main transparency features you’ll fi nd in 
Illustrator CS2 and InDesign CS2:

Drop shadow
When you add a drop shadow to an object, a soft -edged duplicate shape of the object is displayed 
behind the object, making it appear that a shadow is being cast on the page background or any under-
lying objects. Th e eff ect can be a blending of the shadow with underlying objects.

Feathering
Feathering soft ens the edges of an object by fading the object from opaque to transparent over a user-
defi ned distance. Feathering the edge of an object causes the object to fade smoothly outward and 
blend into the page background or any objects behind it.

Blending mode
When you apply any of several blending modes, you can vary the way the colors of objects blend with 
the colors of underlying objects. 

Opacity
You can vary the degree of transparency of an object or a group by adjusting its opacity. An object 
with an opacity of 100% is totally opaque (that is, you can’t see anything behind it); an object with an 
opacity of 0% is totally transparent. As you decrease an object’s opacity, the page background or any 
underlying objects become increasingly visible through the object.

Opacity (50%).

Feathering (12pt. sharp).

Blending mode (screen).

Drop shadow.
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Flattening
If you’re going to create transparency eff ects, you should also understand a little bit about fl attening. 
All transparent objects in a fi le—as well as all linked graphic fi les that interact with transparency—
must be fl attened for print output, including Adobe PostScript®, Encapsulated PostScript (EPS), or 
when saving as PDF 1.3 and earlier.

At its simplest, the process of fl attening converts all overlapping areas in a stack of transparent objects 
into a collection of opaque objects that retains the appearance of the original transparent objects when 
printed.

S
These illustrations show how 
fl attening is performed on an InDesign 
page. (Flattening is the same on an 
Illustrator page.)

1) The jellyfi sh is a vector graphic 
created in Illustrator. A 5-point 
feathered edge was added 
in InDesign.

2) The S text character was created 
in InDesign. It has a 70% black drop 
shadow, and the Multiply blending 
mode is applied to the shadow.

3) The starfi sh is a placed .tif image. 
The Multiply blending mode was 
applied in InDesign.

4) The purple background shape is an 
InDesign object.

When Highlight: All Aff ected Objects is 
selected, areas that are aff ected by fl attening 
are displayed in pink, while areas that are not 
aff ected by fl attening are displayed in gray.

This 3D representation shows what 
happens when the objects are 
fl attened. The top layer shows the 
resulting vector shapes—the letter 
“S” and three pieces of the purple 
background object. The middle layer 
shows the rasterized areas, which 
include the jellyfi sh, the starfi sh, and 
portions of the purple background 
object. The bottom layer shows how 
the vector areas and raster areas 
are combined to produce the fi nal 
artwork.

The Flattener Preview palette in InDesign, 
Illustrator, and Acrobat highlights transparent 
objects/images, as well as areas aff ected by 
transparency.
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Creating transparency eff ects
 Transparency is an eff ect applied to an object, like a stroke or a fi ll applied to a piece of vector art. You 
can apply one or more transparency eff ects to any object—for example, a text frame, a placed graphic, 
or a shape created with any drawing tool can each have diff erent transparency eff ects applied. You can 
also apply transparency eff ects to a group of objects. It’s also possible to add transparency to a docu-
ment by importing/placing transparent artwork created in another application. For example, you can 
place a native Photoshop CS2 fi le with a feathered edge into an Illustrator CS2 layout, or you can place 
an Illustrator CS2 fi le with a soft  drop shadow into an InDesign CS2 layout.

Keep in mind when working with transparent objects that as the number of overlapping transparent 
objects increases, so does the complexity of the transparency eff ects. For example, placing shad-
owed text in front of only the page background is simpler than placing shadowed text in front of an 
imported graphic—in the latter case, the transparency eff ect (the drop shadow) must be combined 
with the underlying graphic for display and printing. You are not likely to encounter problems if you 
apply transparency eff ects to isolated objects that do not overlap with other objects or colors. 

When you’re creating transparency eff ects, you should be careful not to create eff ects that produce 
undesirable results. For example, it’s possible to feather the edge of small type with fi ne serifs, but if 
you do, the resulting text might be diffi  cult or impossible to read or print. Use good judgement when 
designing with transparency.

Object stacking order and transparency
Every time you create a new object, it’s placed on top of all existing objects. (For layouts with multiple 
layers, new objects are placed at the top of the selected layer.) You create a stack of objects, one on top 
of the other called the stacking order. Stacking order becomes more complicated when you’re working 
with a group or a layer, each of which has its own stacking order and can have transparency applied 
diff erently to an object, a group of objects, or a layer of objects. You can adjust the stacking order of an 
object by moving it forward or backward relative to other objects on the layer or page. Layers (and the 
objects in layers) are also organized in a stacking order—the layers at the top of the list in the Layers 
palette (Window > Layers) are in front of the layers at the bottom of the list. Th e stacking order of 
objects is critical for correct display and printing of transparency. 

Transparency eff ects don’t have to involve overlapping objects, but they oft en do. For example, you 
can apply an opacity value that’s less than 100% to lighten any object, regardless of whether the object 
is in front of other objects. However, by applying a lower opacity value, you not only make an object 
lighter, you also make it semi-opaque, which causes it to blend with any underlying objects it overlaps.

 When you’re working with transparent objects that overlap, remember that changing the stacking 
order can change the appearance of overlapping areas. When you create transparency eff ects that 
involve overlapping objects, make sure the stacking order produces the intended results.

Generally, type should be on top of all other objects unless it needs to interact with transparency. 
Placing text frames and spot colors on the top of the stacking order will help keep them from being 
involved in transparency fl attening.

The three examples below show how 
complexity grows when you combine 
transparency eff ects and overlapping 
objects. All three examples use a 
native InDesign text frame and a 
placed graphic.

No transparency eff ects are applied to 
either object.

Drop shadows are applied to both 
objects.

The Luminosity blending mode is 
applied to the text frame.

Jellyfi sh in front. Purple object in front (with Overlay 
blending mode applied).

 The two examples above show how stacking order can aff ect transparent objects. Both examples contain similar-looking 
purple and yellow objects. The yellow jellyfi sh is a placed Illustrator graphic; the purple shape is a native InDesign object. In 
both examples, the Overlay blending mode is applied to the purple object; no transparency is applied to the jellyfi sh. The only 
diff erence between the left pair of objects and the right pair is that the stacking order is reversed. On the left, the jellyfi sh is in 
front of the purple object; on the right, the purple object is in front of the jellyfi sh. In general, you should apply transparency to 
objects that are in front of other objects so that the objects in front blend with the objects behind.

S

S
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 Saving, exporting, and printing fi les with transparency
When you save or export a document with transparency as PDF 1.3 (Acrobat 4) or EPS, or print the 
document, you must specify the transparency fl attener settings. Th ese settings are saved in a fl attener 
preset (a reusable collection of transparency fl attener settings). Th e preset you choose determines how 
fl attening is performed on objects that interact with transparency.

Where necessary, fl attening converts vector artwork and text into bitmaps (this process is called 
rasterization). Other eff ects, like drop shadows and feathers, are raster eff ects themselves. To save, 
export, and print these eff ects properly, you must specify the appropriate rasterization resolution in 
the fl attener setting you use.

Both Illustrator CS2 and InDesign CS2 soft ware include three built-in transparency fl attener presets: 
Low Resolution, Medium Resolution, and High Resolution. You can also create your own custom fl at-
tener presets. Adobe Acrobat® 7 also provides fl attening controls in the Advanced Print Setup dialog 
box (File > Print > Advanced > Transparency Flattening) and the Flattener Preview window (Tools > 
Print Production > Transparency Flattening). (Note: You cannot create fl attener presets with Acrobat 7.) 
Transparency fl attener presets are available when you save PDF fi les with Illustrator CS2, export PDF 
fi les with InDesign CS2, and print fi les with transparency from these applications. Here are some basic 
guidelines for choosing a transparency fl attener preset:

•  Choose the Low or Medium Resolution fl attener preset for desktop proofs printed on black-and-
white desktop printers.

•  Choose the Medium Resolution fl attener preset for desktop proofs and print-on-demand 
documents printed on PostScript color printers.

•  Choose the High Resolution fl attener preset for imagesetters and other high resolution output 
devices. If you’re creating a PDF for a print service provider, ask them for their preferred 
transparency fl attener preset or fl attener settings. Generally, the best practice is to use the High 
Resolution preset or get a customized preset from your service provider. (You can also create your 
own customized fl attener presets.) Specifying the correct fl attener settings—especially resolution—
is critical for achieving the intended high-quality output.

You should consult your print service provider before fl attening any transparent artwork. Because fl at-
tening includes resolution settings, the printer typically needs to specify what settings to use.

 Exporting fi les with transparency
 If you’re creating a standalone fi le that contains transparent objects—that is, a layout you don’t intend 
to use in other layouts or other applications—you can save the document as a native Photoshop CS2, 
native Illustrator CS2 (.AI), or native InDesign CS2 (.INDD) fi le by using the Save command (File 
menu). However, if you intend to use the design in another layout or application, you must decide 
whether to save the document as a native fi le or export the document in a diff erent fi le format.

Whenever possible, you should use fi le formats that preserve live transparency—including native 
Photoshop CS2 and Illustrator CS2 fi le formats, or PDF 1.4 (Acrobat 5), PDF 1.5 (Acrobat 6), or PDF 
1.6 (Acrobat 7) fi les—when you’re creating graphic fi les for placement in other documents. Th ese 
Adobe applications are built to work together, and they let you view and output native fi le formats and 
transparency eff ects.

When you create an Adobe PDF fi le using Acrobat Distiller®, PostScript must fi rst be generated from 
the artwork. Because live transparency can not be represented in PostScript, fl attening must occur. As 
a result, the PDF fi le contains no live transparency. When you save or export Adobe PDF documents 
directly from Illustrator or InDesign, Distiller is not used, and as a result, live transparency is retained 
in PDF 1.4 and later.

Saving fi les in native formats for placement into other Adobe applications provides several advantages 
over other fi le format options:

• Greater control at print time. Using native fi le formats with live transparency gives you control over 
the fl attener and resolution settings up to the time you print, save, or export a job in a non-native 
fi le format (such as PostScript).
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• Reduce fi le overhead. By saving a single, native, and unfl attened version of a graphic instead of 
multiple, exported TIFF or EPS fi les, you reduce the number of fi les you have to track. You also 
reduce the disk space required to store your graphics.

• Easy editability. InDesign CS2 lets you place native Photoshop CS2, native Illustrator CS2, 
and Illustrator CS2 PDF 1.4, PDF 1.5, and PDF 1.6 fi les, which in turn lets you preserve live 
transparency throughout the page layout workfl ow. Other formats can fl atten Illustrator objects, 
making them uneditable. Flattened Illustrator objects force you to open the original fi le in 
Illustrator CS2, make the changes, export and fl atten the fi le again (ensuring again that the 
rasterization resolution is set correctly), and fi nally relink the placed graphic in InDesign CS2. 
When placed into InDesign, an Illustrator object with live transparency interacts with objects 
below it on the InDesign page as though the transparency eff ects were created within InDesign.

 If you need to make changes to a native Illustrator CS2 graphic, you can simply open the fi le 
in Illustrator CS2 and make the changes. (While working in InDesign, you can easily open an 
Illustrator fi le by selecting it in the Links palette and then choosing Edit Original from the palette 
menu.) When you modify a placed native Illustrator CS2 graphic that has live transparency, all 
instances of the graphic in InDesign CS2 documents are updated. When it’s time to print the 
fi nished InDesign CS2 document, the print/prepress service provider can fl atten all transparency 
at once directly from within InDesign CS2 by using the program’s fl attener controls. If you need to 
place transparent artwork into non-Adobe applications that don’t support live transparency, you 
must save the artwork in a fl attened format.

When you use the Save or Save As command in Illustrator CS2 to export a fi le with transparency, you can choose a transparency 
fl attener preset in the Advanced panel of the Adobe PDF Options dialog box. The same menu for choosing a transparency fl at-
tener preset is available when you export an InDesign CS2 document as PDF (File > Export).

Remember, when you export a document (including Photoshop CS2, Illustrator CS2, and InDesign 
CS2 documents) to any fi le format that fl attens transparency, the document is fl attened in the same 
way it’s rasterized when printed, and you lose the ability to edit the original objects. Th e exceptions are 
when you reopen Illustrator CS2 EPS fi les in Illustrator CS2 and when you reopen PDF 1.3 fi les for 
which Preserve Illustrator Editing Capabilities was selected in the Adobe PDF Options dialog box when 
the fi le was saved. EPS fi les are considered fl attened when they are placed into any other application.
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 Printing fi les with transparency
When you want to print a document—whether the output device is a relatively low-resolution proof 
printer or a high-resolution imagesetter—all transparent objects in the fi le, as well as any linked fi les 
that contain live transparency, must be fl attened. Th at is, the transparency information in the fi le must 
be converted into a format the printer can understand. In most cases, fl attening produces excellent 
results when you use appropriate fl attener settings or a fl attener preset. 

The transparency fl attener preset you choose in the Advanced panel of the Print dialog box in both InDesign CS2 (shown) and 
Illustrator CS2 determines how transparency eff ects are fl attened during printing.

 Preparing and delivering fi les for high-resolution printing
If your documents contain complex, overlapping areas of transparency and you require high-resolu-
tion output, you should work closely with your print service provider. Your print service provider 
can specify optimal fl attener settings based on the fi le formats used, the resolution of the fi nal output 
device, and their workfl ow. Good communication between you and your service provider will help 
you achieve the results you expect.

If your printer will handle fl attening, you should provide a native fi le or an Adobe PDF 1.4, PDF 1.5, 
or PDF 1.6 fi le. If Adobe PDF 1.3 or PDF/X fi les are requested (these fi le formats must be fl attened), 
consult with the person responsible for printing your documents about the recommended fl attener 
and resolution settings. Acrobat 7 Professional has several PDF/X creation and validation features. 
(Note: InDesign CS2 includes built-in PDF/X export capabilities.)

Not all service providers support all fi le types. Make sure to check with your service provider, and ask 
them what fi le types they accept.

If your print service provider would like more information about printing fi les with transparency, you 
can point them to the Adobe Print Resource Center page at studio.adobe.com/us/print/main.jsp.
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 Transparency-related resources
If you would like additional information about working with transparency and printing documents 
that contain transparency, please refer to:

• A Designer’s Guide to Transparency for Print Output Using Adobe Creative Suite 2 Soft ware. Th is 
document contains detailed information about transparency and using the transparency features in 
Illustrator CS2 and InDesign CS2. (studio.adobe.com/us/print/main.jsp)

• Transparency in Adobe Applications: A Print Production Guide. Th is reference and 
troubleshooting guide for prepress providers contains detailed information about printing fi les 
with transparency. (studio.adobe.com/us/print/main.jsp)

• Adobe Systems and PDF/X. Th is document contains information about the PDF/X format and the 
support of PDF/X in Adobe applications. (www.adobe.com/products/acrobat/pdfs/pdfx_faq.pdf)

• Th e Adobe Solutions Network Partner Find An ASN Print Service Provider Web page. You can use 
this web page to search for an Adobe Solutions Network print service provider. (partners.adobe.
com/public/partnerfi nder/psp/show_fi nd.do)

• Th e Adobe Support Knowledgebase. Th is is a good place to start if you’re looking for information 
about any Adobe product. Th e searchable database is helpful if you need information about known 
problems and solutions relating to Adobe products. (www.adobe.com/support/main.html)

• Adobe InDesign Support. Th is page includes links to several helpful InDesign resources, as well as 
several top InDesign issues. (www.adobe.com/support/products/indesign.html)

• Adobe Illustrator Support. Th is page includes links to several helpful Illustrator resources, as well 
as several top Illustrator issues. (www.adobe.com/support/products/illustrator.html)

• Adobe Acrobat Support. Th is page includes links to several helpful Acrobat resources, as well as 
several top Acrobat issues. (www.adobe.com/support/products/acrobat.html)
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